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CE Mark

The CE marking applied to this product symbolises Rank Xerox’s declaration of conformity with the following applicable directives of the European Union as of 
the dates indicated.

January 1, 1996—Council Directive 70/80/CCO amended by Council Directive 93/68/EEO. Approximation of the laws of the member states related to low 
voltage equipment.

January 1, 1996—Council Directive 59/336/EEC. Approximation of the laws of the member states related to electromagnetic compatibility.

A full declaration defining the relevant directives and referenced standards can be obtained from your Rank Xerox representative.

WARNING: In order to allow this equipment to operate in proximity to industrial, scientific, and Medical (ISM) equipment, the external radiation from 
ISM equipment may have to be limited or special migration measures taken.

WARNING: This is a Class A product. In a domestic environment this product may cause radio interference, in which case the user may be required to 
take adequate measures.

FCC Information

WARNING: FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly approved by the manufacturer could void 
the user’s authority to operate this equipment. 

NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, 
and uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is likely to cause interference in which case the user will be required to correct the interference 
at his own expense. 

Industry Canada Class A Notice

This digital apparatus does not exceed the Class A limits for radio noise emissions from digital apparatus as set out in the interference-causing equipment standard 
entitled, “Digital Apparatus” ICES-003 from Industry Canada.

Avis de Conformation Classe A d l’Industrie Canada 

Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites applicables aux appareils numériques de la Classe A prescrites dans la 
norme sur le matériel brouilleur, “Appareils Numériques” NMB-003 édictée par l’Industrie Canada.

Certificate by Manufacturer/Importer

This is to certify that the FC07 is shielded against radio interference in accordance with the provisions of VFG 243/1991. The German Postal Services have been 
advised that this device is being put on the market and that they have been given the right to inspect the series for compliance with the regulations.
Electronics for Imaging, Inc.

Bescheinigung des Herstellers/Importeurs

Heirmit wird bescheinigt, dass der FC07 im Uebereinstimmung mit den Bestimmungen der VFG 243/1991 Funk-Entstort ist. Der Deutschen Bundespost wurde 
das Inverkehrbringen dieses Geraetes angezeigt und die Berechtigung zur Ueberpruefung der Serie auf Einhaltung der Bestimmungen eingeraumt.
Electronics for Imaging, Inc.

RFI Compliance Notice

This equipment has been tested concerning compliance with the relevant RFI protection requirements both individually and on system level (to simulate normal 
operation conditions). However, it is possible that these RFI Requirements are not met under certain unfavorable conditions in other installations. It is the user 
who is responsible for compliance of his particular installation.

Dieses Geraet wurde einzeln sowohl als auch in einer Anlage, die einen normalen Anwendungsfall nachbildet, auf die Einhaltung der Funk-entstoerbestimmungen 
geprueft. Es ist jedoch moeglich, dass die Funk-enstoerbestimmungen unter unguenstigen Umstaenden bei anderen Geraetekombinationen nicht eingehalten 
werden. Fuer die Einhaltung der Funk-entstoerbestimmungen seigner gesamten Anlage, in der dieses Geraet betrieben wird, ist der Betreiber verantwortlich.

Compliance with applicable regulations depends on the use of shielded cables. It is the user who is responsible for procuring the appropriate cables.

Einhaltung mit betreffenden Bestimmungen kommt darauf an, dass geschirmte Ausfuhrungen gebraucht werden. Fuer die beschaffung richtiger Ausfuhrungen 
ist der Betreiber verantwortlich.



            
Software License Agreement

Before using the Software, please carefully read the following terms and conditions. BY USING THIS SOFTWARE, YOU SIGNIFY THAT YOU HAVE 
ACCEPTED THE TERMS OF THIS AGREEMENT.  If you cannot or do not accept these terms, you may return the entire package within ten (10) days to 
the Distributor or Dealer from which you obtained them for a full refund.

Electronics for Imaging, Inc. grants to you a non-exclusive, non-transferable license to use the software and accompanying documentation (“Software”) included 
with the DocuColor 40 CP you have purchased, including without limitation the PostScript® software provided by Adobe Systems Incorporated.

You may:

a. use the Software solely for your own customary business purposes and solely with DocuColor 40 CP;

b. use the digitally-encoded machine-readable outline and bitmap programs (“Font Programs”) provided with DocuColor 40 CP in a special encrypted format 
(“Coded Font Programs”) to reproduce and display designs, styles, weights, and versions of letters, numerals, characters and symbols (“Typefaces”) solely for your 
own customary business purposes on the display window of the DocuColor 40 CP or monitor used with DocuColor 40 CP;

c. use the trademarks used by Electronics for Imaging to identify the Coded Font Programs and Typefaces reproduced therefrom (“Trademarks”); and

d. assign your rights under this Agreement to a transferee of all of your right, title and interest in and to DocuColor 40 CP provided the transferee agrees to be 
bound by all of the terms and conditions of this Agreement.

You may not:

a. make use of the Software, directly or indirectly, to print bitmap images with print resolutions of 600 dots per inch or greater, or to generate fonts or typefaces 
for use other than with DocuColor 40 CP;

b. make or have made, or permit to be made, any copies of the Software, Coded Font Programs, accompanying documentation or portions thereof, except as 
necessary for use with the DocuColor 40 CP unit purchased by you; provided, however, that under no circumstances may you make or have made, or permit to 
be made, any copies of that certain portion of the Software which has been included on the DocuColor 40 CP hard disk drive. You may not copy the 
documentation; 

c. attempt to alter, disassemble, decrypt or reverse engineer the Software, Coded Font Programs or accompanying documentation.

d. rent or lease the Software.

Proprietary Rights

You acknowledge that the Software, Coded Font Programs, Typefaces, Trademarks and accompanying documentation are proprietary to Electronics for Imaging 
and its suppliers and that title and other intellectual property rights therein remain with Electronics for Imaging and its suppliers. Except as stated above, this 
Agreement does not grant you any right to patents, copyrights, trade secrets, trademarks (whether registered or unregistered), or any other rights, franchises or 
licenses in respect of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation. You may not adapt or use any trademark or 
trade name which is likely to be similar to or confusing with that of Electronics for Imaging or any of its suppliers or take any other action which impairs or reduces 
the trademark rights of Electronics for Imaging or its suppliers. The trademarks may only be used to identify printed output produced by the Coded Font 
Programs. At the reasonable request of Electronics for Imaging, you must supply samples of any Typeface identified with a trademark.

Confidentiality

You agree to hold the Software and Coded Font Programs in confidence, disclosing the Software and Coded Font Programs only to authorized users having a need 
to use the Software and Coded Font Programs as permitted by this Agreement and to take all reasonable precautions to prevent disclosure to other parties.

Remedies

Unauthorized use, copying or disclosure of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation will result in automatic 
termination of this license and will make available to Electronics for Imaging other legal remedies.

Limited Warranty And Disclaimer

Electronics for Imaging warrants that, for a period of ninety (90) days from the date of delivery to you, the Software under normal use will perform without 
significant errors that make it unusable. Electronics for Imaging’s entire liability and your exclusive remedy under this warranty (which is subject to you returning 
DocuColor 40 CP to Electronics for Imaging or an authorized dealer) will be, at Electronics for Imaging’s option, to use reasonable commercial efforts to attempt 
to correct or work around errors, to replace the Software with functionally equivalent software, or to refund the purchase price and terminate this Agreement. 
Some states do not allow limitations on duration of implied warranty, so the above limitation may not apply to you.

Except for the above express limited warranty, Electronics for Imaging makes and you receive no warranties or conditions on the Products, express, implied, or 
statutory, and Electronics for Imaging specifically disclaims any implied warranty or condition of merchantability or fitness for a particular purpose.

For warranty service, please contact your authorized service/support center.



           
EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY, ELECTRONICS FOR IMAGING MAKES AND YOU RECEIVE NO WARRANTIES 
OR CONDITIONS ON THE SOFTWARE OR CODED FONT PROGRAMS, EXPRESS, IMPLIED, STATUTORY, OR IN ANY OTHER PROVISION 
OF THIS AGREEMENT OR COMMUNICATION WITH YOU, AND ELECTRONICS FOR IMAGING SPECIFICALLY DISCLAIMS ANY IMPLIED 
WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Electronics for Imaging does not warrant that 
the operation of the software will be uninterrupted or error free or that the Software will meet your specific requirements.

Limitation Of Liability

IN NO EVENT WILL ELECTRONICS FOR IMAGING OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES, INCLUDING LOSS OF DATA, LOST 
PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES ARISING FROM THE USE OF 
THE SOFTWARE, CODED FONT PROGRAMS OR ACCOMPANYING DOCUMENTATION, HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY. THIS LIMITATION WILL APPLY EVEN IF ELECTRONICS FOR IMAGING OR ANY AUTHORIZED DEALER HAS BEEN ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGE. YOU ACKNOWLEDGE THAT THE PRICE OF THE UNIT REFLECTS THIS ALLOCATION OF RISK. 
BECAUSE SOME STATES/JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR 
INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

Export Controls

You agree that you will not export or re-export the Software or Coded Font Programs in any form without the appropriate United States and foreign government 
licenses. Your failure to comply with this provision is a material breach of this Agreement.

Government Use

Use, duplication or disclosure of the Software by the United States Government is subject to restrictions as set forth in subdivision (c) (1) (ii) of the Rights in 
Technical Data and Computer Software clause at DFARS 252.227-7013 or in subparagraphs (c) (1) and (2) of the Commercial Computer Software—Restricted 
Right Clause at 48 CFR 52.227-19, as applicable.

Third Party Beneficiary

You are hereby notified that Adobe Systems Incorporated, a California corporation located at 345 Park Avenue, San Jose, CA  95110-2704 (“Adobe”) is a third-
party beneficiary to this Agreement to the extent that this Agreement contains provisions which relate to your use of the Fonts, the Coded Font Programs, the 
Typefaces and the Trademarks licensed hereby.  Such provisions are made expressly for the benefit of Adobe and are enforceable by Adobe in addition to Electronics 
for Imaging.

General

This Agreement will be governed by the laws of the State of California.

This Agreement is the entire agreement held between us and supersedes any other communications or advertising with respect to the Software, Coded Font 
Programs and accompanying documentation.

If any provision of this Agreement is held invalid, the remainder of this Agreement shall continue in full force and effect.

If you have any questions concerning this Agreement, please write to Electronics for Imaging, Inc., Attn: Licensing Dept. or see Electronics for Imaging’s web site 
at www.efi.com.

Electronics for Imaging, Inc.
2855 Campus Drive
San Mateo, CA 94403
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ix About the documentation

             
This manual describes how to install the user software for the DocuColor 40 CP Color 
Server™ and set up printing from Windows and Mac OS computers. For information 
about setting up network servers and clients to use the DocuColor 40 CP Color 
Server, see the Configuration Guide. For general information on using the color copier, 
your computer, your application software, or your network, see the manuals that 
accompany those products.

Your DocuColor 40 CP includes a media pack containing:

• User Software CD

• System Software CD

• User Documentation CD

• Printed Release Notes (described below)

• Quick Start Notes

About the documentation
This manual is part of the set of DocuColor 40 CP documentation, which includes the 
following manuals for users and system administrators:

• The Configuration Guide explains basic configuration and administration of the 
DocuColor 40 CP for the supported platforms and network environments. It also 
includes guidelines for setting up UNIX, Windows NT, and NetWare servers to 
provide PostScript printing services to clients.

• Getting Started describes how to install software to enable users to print to the 
DocuColor 40 CP. Specifically, it describes installation of PostScript printer drivers, 
printer description files, and other software provided on the User Software CD. It 
also explains how to connect networked client workstations to the 
DocuColor 40 CP for printing and client utility use.

• The Printing Guide describes the printing features of the DocuColor 40 CP for users 
who send jobs via remote workstations on the network or via a direct parallel port 
connection.

Introduction



 

x Introduction

               
• The Color Guide provides an introduction to the basics of color theory and printing 
to a DocuColor 40 CP Color Server. It also includes practical color printing tips and 
application notes that explain how to print to the DocuColor 40 CP from popular 
Windows and Mac OS applications.

• The Job Management Guide explains the functions of the DocuColor utilities and 
WebTools, and how they can be used to manage jobs and maintain color quality. 
This book is intended for an operator or administrator, or a user with the necessary 
access privileges, who needs to monitor and manage job flow, perform color 
calibration, and troubleshoot problems that may arise. 

• Release Notes provide last-minute product information and workarounds for some of 
the problems you may encounter.

Specifications
The DocuColor 40 CP has the following features:

• MIPS R5000, 200 MHz CPU

• 128MB RAM (upgrade to 512MB available as an optional kit)

• Internal 4GB hard disk drive

• External 12x CD-ROM drive

• SCSI port

• Supports AppleTalk, TCP/IP, and IPX protocols simultaneously

• Supports parallel port communication

• Supports thinnet (thin coaxial Ethernet cable or 10Base2), thicknet (thick coaxial 
Ethernet cable or 10Base5), and unshielded twisted pair (Fast Ethernet 100BaseTX 
or Ethernet 10BaseT)

• Supports Token Ring networking (available as an optional kit)

• Supports Adobe PostScript 3

• Includes 136 fonts (117 Adobe Type 1 PostScript and 19 TrueType)

In addition, two Adobe Multiple Master fonts are included and are used for font 
substitution in PDF files.

• Built-in ColorWise™ color management and NetWise™ networking features



 

xi User software

           
• WebTools™

• Downloader™ and Print Calibrator™ client utilities

User software
The full set of DocuColor 40 CP user software is provided on the User Software CD. 
Installers for the printer files can also be downloaded with the Installer WebTool (see 
page 58).

Adobe PostScript Printer 
Driver

Enables you to print to the DocuColor 40 CP from 
Windows NT 4.0, Windows 3.1x, Windows 95, 
and Mac OS computers; supports special 
DocuColor 40 CP and PostScript 3 features.

PostScript Printer Description 
files (PPDs)

Files for use with the PostScript printer driver; they 
allow the DocuColor 40 CP to appear in popular 
applications’ Print and Page Setup dialog boxes. The 
DocuColor 40 CP PPDs provide information about 
the DocuColor 40 CP and your particular copier 
model to the application and printer driver you are 
using.

PostScript Screen Fonts Screen fonts for the 136 printer fonts installed on 
the DocuColor 40 CP (117 Adobe Type 1 and 19 
TrueType). See Appendix B of the Printing Guide 
for a complete list.

Downloader Enables you to print PostScript files, Encapsulated 
PostScript (EPS) files, and Portable Document 
Format (PDF) files directly to the 
DocuColor 40 CP without opening the application 
in which they were created. Downloader also 
enables you to manage the printer fonts installed on 
the DocuColor 40 CP.



 

xii Introduction

        
System requirements
To install the DocuColor 40 CP user software on a Windows or Mac OS computer, 
the computer must be equipped with a built-in or external CD-ROM drive.

Windows
To print to the DocuColor 40 CP, you need:

• A Windows-based computer with an 80486, AMD, or Pentium processor

• Windows 95, Windows 3.1x, or Windows NT 4.0

• At least 4MB of RAM

To use the DocuColor utilities (Downloader and Print Calibrator) you also need:

• Either Windows 95 or Windows NT 4.0 with NT Service Pack 3

• At least 16MB of RAM

Print Calibrator Enables you to calibrate the DocuColor 40 CP 
remotely from a Windows 95, Windows NT 4.0, or 
Mac OS computer. Proper calibration keeps color 
consistent across time. Also allows you to create 
custom calibration and simulation targets.

Color management files ColorSync and ICM color management files that 
enable you to maintain consistent color from your 
original artwork to the colors displayed on your 
monitor to the printed output.

Color reference files Reference pages that you can print to view the range 
of colors available on your DocuColor 40 CP. For 
the most predictable color results, refer to these 
pages when defining colors in applications.



 

xiii System requirements

               
To use WebTools, you also need:

• Either Netscape Communicator v4.0.4 with Java enabled or Microsoft Internet 
Explorer v3.0.2 with Java enabled

NOTE: Netscape and Microsoft continue to release frequent updates to their browsers. 
As support cannot be guaranteed for all versions, use the versions specified above for 
best results.

• A monitor that supports 16-bit color at a minimum resolution of 800 x 600

• A TCP/IP enabled network and the IP address or DNS name of the 
DocuColor 40 CP

• Web Services enabled on the DocuColor 40 CP

NOTE: DocuColor utilities and WebTools are not supported with Windows 3.1x or 
over IPX (Novell) or IPX/SPX networks.

With Microsoft Windows 95, you also need:

• IPX/SPX or TCP/IP networking protocol installed

• Adobe PostScript Printer Driver for Windows version 4.2 or later (version 4.2.2 is 
included with the user software)

With Microsoft Windows 3.1x, you also need:

• IPX networking protocol installed

• IPX/SPX networking software for IPX/SPX communication

• MS-DOS version 5.0 or later

• Adobe PostScript Printer Driver for Windows version 3.0 or later (version 3.1.2 is 
included with the user software)

With Microsoft Windows NT 4.0 you also need:

• TCP/IP or AppleTalk networking protocol installed

• Adobe PostScript Printer Driver for Windows version 5.0 (included with the user 
software)
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Mac OS
To print to the DocuColor 40 CP, you need:

• A Mac OS-based computer

• At least 8MB of RAM

• EtherTalk installed

• Apple System software version 7.5 or later

• Adobe PostScript Printer Driver version 8.5 or later (version 8.5.1 is included with 
the user software)

To use the DocuColor utilities (Downloader and Print Calibrator), you also need:

• A Power Macintosh computer

• At least 16MB of RAM

To use WebTools, you also need:

• Netscape Communicator v4.0.4 with Java enabled

NOTE: Netscape continues to release frequent updates to its browser. As support cannot 
be guaranteed for all versions, use the version specified above for best results.

• A TCP/IP enabled network and the IP address or DNS name of the 
DocuColor 40 CP

• Web Services enabled on the DocuColor 40 CP

UNIX (TCP/IP)
To print to the DocuColor 40 CP with a UNIX workstation, you need:

• A workstation with standard TCP/IP connectivity (for example, Sun SPARCstation 
or Silicon Graphics workstation with Solaris version 2.x or SunOS version 4.1.x 
software)

• TCP/IP printing software that conforms to RFC1179 (Berkeley lpd protocol)
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Parallel port
To print to the DocuColor 40 CP using the parallel port, you need:

• A Windows-based computer with an 80486, AMD, or Pentium processor

• At least 4MB of RAM

• The parallel cable included with the DocuColor 40 CP

The cable has a DB-25 male connector (that connects to the computer) on one end 
and a DB-25 female connector (that connects to the DocuColor 40 CP) on the 
other.

IPX (Novell)
To use the DocuColor 40 CP with an IPX (Novell) network, you need:

• A Novell server

• Novell NetWare software version 4.x or 3.x

• Support for Ethernet SNAP, Ethernet II, Ethernet 802.3, Ethernet 802.2, 
Token Ring SNAP, or Token Ring





 

1 Installing Windows software

   
This chapter describes installing software and setting up printing from a 
Windows-based computer running Windows 95, Windows 3.1x, or Windows NT 4.0.

The general steps for installing the DocuColor 40 CP software are:

• Install the Adobe PostScript printer driver and PostScript Printer Description files 
(PPDs) for all Windows systems.

• Set up the printer driver to communicate with the DocuColor 40 CP.

• For Windows 95 and Windows NT 4.0 only, install the DocuColor utilities 
(Downloader and Print Calibrator).

• Configure the connection for Downloader and Print Calibrator.

• Copy additional color reference and application files from the User Software CD as 
needed.

Installing Windows software
The Instalrs folder on the User Software CD contains the following installer folders:

• Calib—Print Calibrator installer

• Download—Downloader installer

• Ps_drvr—Adobe PostScript printer driver installers and DocuColor 40 CP PPD files 
for all supported Windows systems

In addition, the User Software CD includes various color files. These files can be 
copied or installed from the CD and placed in the appropriate locations on your hard 
disk (see “Copying color files from the User Software CD” on page 39):

• ICM printer profiles

• Separation Tables and a monitor settings file for use with Adobe Photoshop

• PostScript CMYK reference file

• PostScript PANTONE Coated Color Reference file

• RGB color reference files for specifying colors from Microsoft Word and PowerPoint

Installing 
User Software 
on a Windows 
Computer



 

2 Installing User Software on a Windows Computer

                                
Downloading printer files with the Installer WebTool

Installers for the DocuColor 40 CP printer files can be downloaded from the 
DocuColor 40 CP with the Installer WebTool (if the site administrator has enabled 
Internet access to the DocuColor 40 CP). For instructions, see “Using the Installer 
WebTool” on page 58.

Once you download the installers, the installation process is identical to installing from 
the User Software CD.

Setting up the DocuColor 40 CP as a PostScript printer
To set up the DocuColor 40 CP as a PostScript printer, you need a PostScript printer 
driver and the appropriate DocuColor 40 CP PPD file.

Install the appropriate Adobe PostScript printer driver, included with the 
DocuColor 40 CP user software. All drivers are capable of providing access to all 
DocuColor 40 CP features; in addition, the Adobe PostScript printer drivers for 
Windows 95 and Windows NT 4.0 supports PostScript 3.

The following procedures are specific to each version of Windows.

Setting up PostScript printing with Windows 95

You can use the following procedure whether you are installing from the User Software 
CD or with installer files downloaded using the Installer WebTool.

NOTE: If you have problems setting up the DocuColor 40 CP, install another 
PostScript printer such as the Apple LaserWriter, and then install the 
DocuColor 40 CP.

TO INSTALL THE ADOBE POSTSCRIPT PRINTER DRIVER FOR WINDOWS 95:

1. If you are installing from the CD, insert it into the CD-ROM drive, double-click the icon 
of the CD, and open the English\Instalrs\Ps_drvr folders.

If you are installing from the files you downloaded using the Installer WebTool, 
double-click the icon of your hard disk drive, and open the Prntdrv\Ps_drvr folders.

2. Open the Win_95 folder, and double-click the Setup.exe icon.



 

3 Setting up the DocuColor 40 CP as a PostScript printer

     
3. Read the End User License Agreement. If you agree with the terms and conditions of 
the agreement, click Accept.

You must click Accept before setup can continue. If you click Decline, you are 
prompted to either continue with setup or exit.

4. Click Read to view the README file. When you are finished, close the README file and 
click Next.

The information in this file is not specific to your DocuColor 40 CP. You can click 
Next to postpone reading this file and read it later.

5. If you are installing from the CD, you may see an Install Setup Program dialog box 
offering you the option to copy the setup program to your hard disk. Make your choice 
and then click Next.

6. In the Printer Type dialog box, select Local Printer and click Next.

This is a general installation. You can modify the attachment later, according to your 
network type.



 

4 Installing User Software on a Windows Computer

   
7. If you are installing from the CD, in the Directories box, open the 
English\Instalrs\Ps_drvr\Win_95 folders.

If you are installing from the installer files you downloaded with the Installer 
WebTool, in the Directories box, open the Prntdrv\Ps_drvr\Win_95 folders.

The DocuColor 40 CP PPD appears in the Postscript Printer descriptions (PPD’s) 
available box. 

8. Select the DocuColor 40 CP PPD and click Next.

9. In the Available ports box, select the LPT1 port and click Next.

You will configure the port later, according to your network type.
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10. Using a maximum of 20 characters, enter a name for the DocuColor 40 CP (or leave the 
default name) in the Printer Name box.

This name will be used in the Printers and queue windows.

NOTE: Entering more than 20 characters may cause printing problems with some 
network applications.

11. If you want the DocuColor 40 CP to be the default printer select Yes; if not, select No.

12. Select No to printing the test page and click Next.

You will print the test page after you finish configuring the printer.

The necessary files are installed to your hard disk. When installation is complete, the 
Properties dialog box appears.

13. Click OK.

You are notified that Setup is complete.

14. Click Exit.

The icon for your newly installed printer appears in the Printers window.

15. Use the instructions for connecting to your network type (see “Completing the 
Windows 95 connection” below).
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Completing the Windows 95 connection

To print from Windows 95 you need to:

• Set up network servers, if any

• Set up the DocuColor 40 CP to accept print jobs from your computer

• Configure a port on each Windows 95 computer for the network or connection type

Completing the Windows 95 parallel port connection

Preparing a parallel port connection for Windows 95 requires specific BIOS settings 
on your computer, and specific port and printer settings for Windows 95. In addition, 
a change to one of the DocuColor 40 CP Setup settings may be required if you choose 
to spool files to the DocuColor 40 CP rather than print directly.

TO PREPARE THE DOCUCOLOR 40 CP AND YOUR COMPUTER
FOR PARALLEL PORT PRINTING:

1. Connect the DocuColor 40 CP to the parallel port on your computer.

For instructions, see the Configuration Guide.

2. In Network Setup>Port Setup>Parallel Port Setup, set Enable Parallel Port to Yes.

For more information about DocuColor 40 CP Setup, see the Configuration Guide.

3. If you want to spool files to the DocuColor 40 CP, set Port Timeout in Seconds to 10.
If you want to print directly to the DocuColor 40 CP, set Port Timeout in Seconds to 5.

Setting this option to 10 seconds ensures that spooling is not interrupted due to 
timeout.

For this type of connection: See:

Parallel below

IPX/SPX page 11

IPX (Novell) page 12

SMB printing page 13
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4. In your computer’s BIOS settings, set Parallel Port Mode to ECP.

To access the BIOS settings, restart the computer and press the key indicated on your 
monitor as soon as the computer starts up. You may have to scroll through several 
screens to reach the parallel port settings. After setting the Parallel Port Mode to ECP, 
save your changed setting and exit.

TO PREPARE THE PRINTER FOR PARALLEL PORT PRINTING:

1. Click the Start button, point to Settings, and click Printers.

2. Click the DocuColor 40 CP printer icon and choose Properties from the File menu.

3. Click the Details tab, and in the “Print to the following port” menu, select LPT 1: (ECP 
Printer Port).

NOTE: Check this selection carefully. It may read LPT 1: (Printer Port), which is not 
equivalent to LPT 1: (ECP Printer Port).

If this box does not read LPT 1: (ECP Printer Port), change the port setting now, as 
described in “To prepare the port for parallel port printing:” on page 9, and then 
return to this procedure. You may need your Windows 95 system CD.

4. If you changed the selection in the “Print to the following port” menu, click Apply.

A Warning dialog box may appear, stating that fonts you downloaded to the previously 
selected port may be lost; click OK.

5. Click Spool Settings.
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6. Select either “Spool print jobs so program finishes printing faster” or “Print directly 
to the printer.”

The selection you make depends on the action you took in step 3 on page 6:

• If you set the Port Timeout in Seconds to 10, you can select either option; however, 
spooling is faster.

• If you set the Port Timeout in Seconds to 5, select “Print directly to the printer.”

7. Select “Disable bi-directional support for this printer” and click OK.

8. Click Apply.

You are now ready to print from your applications to the DocuColor 40 CP with the 
parallel port. To confirm the connection, print a Windows 95 test page.

9. Click the General tab.

10. Click Print Test Page and click OK.

11. The Job Notes window appears. Type in any information about this job that you want 
and click OK.

Perform the following procedure only if the LPT 1 port is not currently set to 
ECP Printer Port.
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TO PREPARE THE PORT FOR PARALLEL PORT PRINTING:

1. Click the Start button, point to Settings, and click Control Panel.

2. Double-click System.

The System Properties window appears.

3. Click the Device Manager tab.

4. Double-click Ports.

5. Double-click the port with (LPT1) in its name.

6. In the (LPT1) Properties dialog box click the Driver tab and then click Change Driver.

7. Select Show all devices.
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8. From the Manufacturers list, select “(Standard port types).” From the Models list, 
select “ECP Printer Port” (not Printer Port). Click OK.

9. Click OK in the (LPT1) Properties dialog box.

NOTE: You might need to insert the Windows 95 system CD to complete this step 
depending on whether the required files are on your hard disk.

10. When prompted to restart the computer, click Yes.

After Windows 95 restarts, you can complete the procedure described in “To prepare 
the printer for parallel port printing:” on page 7.

Completing the Windows 95 IPX/SPX or IPX (Novell) connection

If you are printing through a Novell server, the Novell network and file server should 
be set up before you begin. The file server should be configured with a print server and 
print connection for the DocuColor 40 CP. For details see your NetWare 
documentation and the Configuration Guide.
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TO SET UP IPX/SPX PRINTING:

1. Open the Windows 95 Control Panel.

2. Double-click the Network icon.

Make sure that IPX/SPX-compatible Protocol and TCP/IP protocol are both listed in 
the Installed Network Components section.

For instructions, see your Windows 95 documentation.

NOTE: You must enable TCP/IP printing to ensure that all files required for IPX/SPX 
will be installed. You can select it and click Remove after you set up IPX/SPX if you do 
not need to use the TCP/IP protocol.

3. Double-click the IPX/SPX-compatible Protocol icon.

4. Click the Advanced tab.

5. In the Property list, click Frame Type. In the Value pop-up menu, select the Frame 
Type that corresponds to the one set during DocuColor 40 CP Network Setup.

If necessary, print the Configuration page from the Control Panel to check which 
Frame Type(s) are configured.
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NOTE: Do not select Auto. Doing so may not select the Frame Type specified on the 
DocuColor 40 CP.

6. Click OK and close the Network Control Panel.

TO SET UP IPX (NOVELL) PRINTING WITH WINDOWS 95:

1. Click the Start button, choose Settings, and then choose Printers.

2. Click the DocuColor 40 CP icon, and choose Properties from the File menu (or 
right-click the icon and left-click Properties).

3. Click the Details tab and click Add Port.

A list of connection options is displayed.

4. In the Add Port dialog box, specify the network path, or click Browse for a display of 
your network environment.

5. If you are using a NetWare file server, double-click the icon of the NetWare file server 
you want to use for printing to the DocuColor 40 CP and click OK. 

6. Click the printer icon labeled with the NetWare print queue you will use and click OK.
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7. In the Add Port dialog box, verify that the network path is updated and click OK.

You are ready to print from the workstation.

Your print jobs are transmitted to the specified print queue on the Novell file server. 
The DocuColor 40 CP polls the file server, and if jobs are present, they are transmitted 
to the DocuColor 40 CP.

To confirm the connection, you can print a Windows 95 test page.

8. Click the General tab, and click Print Test Page.

9. Click OK.

10. The Job Notes window appears. Type in any information about this job that you want 
and click OK.

Completing the SMB printing connection

If you don’t have a Novell network, you can print via SMB printing (also known as 
Windows printing or WINS printing). Printing by this method allows you to print 
from your computer to a particular print connection (Hold, Print, or Direct) on the 
DocuColor 40 CP.

To set up printing to a second or third print connection, you must install a new printer 
for each connection and repeat the procedure “To set up SMB printing:” on page 15. 
If you install more than one printer, give each a descriptive name during printer driver 
installation, such as Astro-Print or Astro-Hold, so you can easily identify printers.

BEFORE YOU BEGIN:

1. Configure the DocuColor 40 CP for SMB printing in Network Setup>Service 
Setup>Windows Setup.

SMB printing is referred to as Windows Printing in Setup, on the Control Panel Map, 
and on the Configuration page. For more information, see the Configuration Guide.

2. Print the DocuColor 40 CP Configuration page.

You need information from the Configuration page to specify settings on your 
computer, such as the Server Name and IP address of the WINS Name Server.

3. Save any documents in open programs.
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You are prompted to restart Windows after this procedure, so be sure to save any 
documents.

TO PREPARE YOUR COMPUTER FOR SMB PRINTING: 

1. Click Start, choose Settings, and click Control Panel.

2. Double-click the Network icon.

3. Select TCP/IP and click Properties.

4. Click the WINS Configuration tab.
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5. Select “Enable WINS Resolution” and enter the TCP/IP address of the WINS Name 
Server.

The TCP/IP address of the WINS Name Server is listed on the Configuration Page in 
the Network Setup section.

6. Click OK, and click OK at the Network dialog box.

You are prompted to restart Windows. Click Yes, and when Windows restarts, 
continue with the following procedure.

TO SET UP SMB PRINTING:

1. Click the Start button, choose Settings, and click Printers.

2. Click the icon for the printer and choose Properties from the File menu.

3. Click the Details tab in the Properties window and click Add Port.

A list of connection options is displayed.

4. In the Add Port dialog box, click Browse to display your network environment.
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5. Expand the levels to locate your printer and the print connection (Print, Hold, or 
Direct) to which you want to print.

The printer name you are browsing for is the Server Name listed under Network Setup 
on the Configuration Page. This name may not be the same as the Server Name listed 
under Server Setup on the Configuration Page (which is the name displayed on the 
Control Panel).

The network environment and the amount of network traffic determines the amount 
of time required for the Browse function.

6. Select the print connection under the printer and click OK.

7. In the Add Port dialog box, verify that the network path is correct and click OK.

8. To confirm the connection, click the General tab in the Properties dialog box.

9. Click Print Test Page, and click OK.

10. The Job Notes window appears. Type in any information about this job that you want 
and click OK.

If the test page prints successfully, you are ready to print from the computer.
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Setting up PostScript printing with Windows 3.1x

You can use the following procedure whether you are installing from the User Software 
CD or with installer files downloaded using the Installer WebTool.

TO INSTALL THE DOCUCOLOR 40 CP PPD FILE FOR WINDOWS 3.1X:

1. In the Main window, double-click the Control Panel icon.

2. Double-click the Adobe PostScript Printers icon.

The Install PostScript Printer from PPD dialog box appears.

NOTE: If there is no Adobe PostScript Printers icon in the Control Panel window, you 
need to install the Adobe PostScript printer driver from the User Software CD. 
Proceed to the procedure “To install the Adobe PostScript printer driver for 
Windows 3.1x:” on page 18.

3. If you are installing from the CD, in the Drives box, select the drive containing the CD 
and, in the Directories box, double-click to open the English\Instalrs\Ps_drvr\Win_31 
folders.

If you are installing from the installer files you downloaded with the Installer 
WebTool, in the Drives box, select your hard disk drive and, in the Directories box, 
double-click to open the Prntdrv\Ps_drvr\Win_31 folders.

4. Select the appropriate DocuColor 40 CP PPD from the Printer Descriptions available 
box and click Install.

5. Click OK when you are notified that the printer was successfully installed.
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TO INSTALL THE ADOBE POSTSCRIPT PRINTER DRIVER FOR 
WINDOWS 3.1X:

1. Exit all applications and close all windows.

2. Insert the User Software CD into the CD-ROM drive.

3. In the Windows Program Manager, choose Run from the File menu, and then click 
Browse.

4. If you are installing from the CD, in the Directories box, double-click to open the 
English\Instalrs\Ps_drvr\Win_31 folders.

If you are installing from the installer files you downloaded with the Installer 
WebTool, in the Directories box, double-click to open the Prntdrv\Ps_drvr\Win_31 
folders.

5. Select the Setup.exe file, and click OK.

6. Click OK in the Run dialog box.

7. Read the End User License Agreement. If you agree with the terms and conditions of 
the agreement, click Accept.

You must click Accept before setup can continue. If you click Decline, you are 
prompted to either continue with setup or exit.

The README.WRI dialog box appears.

8. Click Read to view the README file. When you are finished, close the README file and 
click Continue.

The necessary files are installed to your hard disk. When installation is complete, the 
PostScript Printer Driver Setup dialog box appears.

9. Click Restart Windows. After the computer restarts, return to the procedure “To install 
the DocuColor 40 CP PPD file for Windows 3.1x:” on page 17.
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Setting the DocuColor 40 CP as the default printer with Windows 3.1x

You can specify the DocuColor 40 CP as the default printer. Many Windows 
applications use the default printer when you choose the Print command.

TO SET THE DOCUCOLOR 40 CP AS THE DEFAULT PRINTER:

1. In the Control Panel window, double-click the Printers icon.

The Printers window appears.

2. Select the DocuColor 40 CP from the Installed Printers box.

3. Click Set As Default Printer.

The DocuColor 40 CP appears in the Default Printer area of the Printers window.

Completing the Windows 3.1x connection

To print from Windows 3.1x you need to:

• Configure a port on each Windows 3.1x computer for the network or connection 
type

• Complete setup for the network type you are printing over

• Set up the DocuColor 40 CP to accept print jobs from your computer

Selecting a printer port with Windows 3.1x

When you install a printer, Windows assigns it to a default printer port. If the 
DocuColor 40 CP is connected to your computer through a network or you want to 
assign it to a different port, you need to change the port assignment. Check with your 
system administrator about which port to use.

You can also use this procedure to enable printing with the parallel port.

For this type of connection: See:

Parallel below

IPX (Novell) page 21
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TO SELECT A PRINTER PORT:

1. In the Control Panel window, double-click the Printers icon.

2. In the Printers window, select the DocuColor 40 CP in the Installed Printers list box.

3. Click Connect.

4. Connect the DocuColor 40 CP to the same port as your network.

For parallel printing, select the port (LPT1, LPT2, or LPT3) connected to your 
parallel cable.

To print to a file, select FILE. Printing to a file is useful if the DocuColor 40 CP is 
elsewhere or off-site. However, if you select the FILE port, you cannot print to a 
printer until you select a network or printer port. (In some applications, you can select 
the FILE port from the Print dialog box; this is preferable for temporary use since it 
doesn’t require resetting the port in the Control Panel.)

5. Click OK.

The Printers window appears again, with the selected port next to the selected printer 
name in the Installed Printers list box.

6. When you are finished, click OK and then click Close. 
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Setting up IPX (Novell) printing with Windows 3.1x

TO SET UP IPX (NOVELL) PRINTING:

1. In the Main group of the Windows Program Manager, double-click the Windows Setup 
icon.

2. From the Options menu, choose Change System Settings.

3. From the Network pop-up menu, choose Novell NetWare (shell versions 3.26 and 
above).

4. Click OK. When prompted, restart Windows.

5. In the Main group, double-click Control Panel, then double-click Printers. 

6. In the Printers Control Panel window, select the DocuColor 40 CP and click Connect.

7. Click Network.

If you are printing to a file, select FILE. Printing to a file is useful if the printer is 
elsewhere or off-site. However, if you select the FILE port, you cannot print to a 
printer until you select a network or printer port. If you select Network, the next 
window depends on the NetWare client driver version.

8. If the Network Printer Connections dialog box is displayed, select the port in the 
Printer connections box.
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9. In the Available queues list box, select the server and queue name that correspond to 
the DocuColor 40 CP.

10. Click the Capture button, then click the Close button.

The Connect dialog box is displayed with the network path to the DocuColor 40 CP.

11. Click OK in the Connect dialog box.

The Printers window appears again, with the selected port next to the selected printer 
name in the Installed Printers list box.

12. Click Close in the Printers dialog box.

You are now ready to print to the DocuColor 40 CP from Windows applications. 
When you select Print, jobs are routed to the print queue on the NetWare file server, 
and then transmitted to the DocuColor 40 CP. The network administrator should 
verify the network connection by printing a test document from each networked 
computer that will use the DocuColor 40 CP.

Setting up PostScript printing with Windows NT 4.0

To set up Windows NT 4.0 printing, install the Adobe PostScript printer driver and 
configure printing for your network type. DocuColor 40 CP printer files support 
Intel-based Windows NT 4.0.

You can use the following procedure whether you are installing from the User Software 
CD or with installer files downloaded using the Installer WebTool.

TO INSTALL THE ADOBE POSTSCRIPT PRINTER DRIVER FOR 
WINDOWS NT 4.0:

1. If you are installing from the CD, insert it into the CD-ROM drive, double-click the icon 
of the CD, and open the English\Instalrs\Ps_drvr folders.

If you are installing from the files you downloaded using the Installer WebTool, 
double-click the icon of your hard disk drive, and open the Prntdrv\Ps_drvr folders.

2. Open the Win_nt4x folder, and double-click the Setup.exe icon.

3. Read the End User License Agreement. If you agree with the terms and conditions of 
the agreement, click Yes.
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You must click Yes before setup can continue. If you click Decline, you are prompted 
to either continue with setup or exit.

4. Click Read to view the README file. When you are finished, close the README file and 
click Next.

The information in this file is not specific to your DocuColor 40 CP. You can click 
Next to postpone reading this file and read it later.

5. If you are installing from the CD, you may see an Install Setup Program dialog box 
offering you the option to copy the setup program to your hard disk. Make your choice 
and then click Next.

6. In the Printer Type dialog box, select Local Printer and click Next.

This is a general installation. You can modify the attachment later, according to your 
network type.
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7. If you are installing from the CD, in the Directories box, open the 
English\Instalrs\Ps_drvr\WIN_NT4x folders.

If you are installing from the installer files you downloaded with the Installer 
WebTool, in the Directories box, open the Prntdrv\Ps_drvr\WIN_NT4x folders.

The DocuColor 40 CP PPD appears in the Postscript Printer descriptions (PPD’s) 
available box. 

8. Select the DocuColor 40 CP PPD and click Next.

9. In the Available ports box, select the LPT1 port and click Next.

You will configure the port later, according to your network type.
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10. Indicate whether you want the printer installed as a shared printer. Click Next.

If you select Shared, you must also enter a Share Name for the printer (or leave the 
default name) and make selections from the list of operating systems used by client 
workstations. For information on shared printers, see the Configuration Guide.

11. Using a maximum of 31 characters, enter a name for the DocuColor 40 CP (or leave the 
default name) in the Printer Name box.

This name will be used in the Printers and queue windows.

NOTE: Entering more than 31 characters may cause printing problems with some 
network applications.

12. If you want the DocuColor 40 CP to be the default printer select Yes; if not, select No.
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13. Select No to printing the test page and click Next.

You will print the test page after you finish configuring the printer.

The necessary files are installed to your hard disk. When installation is complete, the 
Properties dialog box appears.

14. Click OK.

You are notified that Setup is complete.

15. Click Exit.

The icon for your newly installed printer will appear in the Printers window.

16. Use the instructions for connecting to your network type (see “Completing the 
Windows NT 4.0 printer connection” below).

Completing the Windows NT 4.0 printer connection

To print from Windows NT 4.0 you need to:

• Set up network servers, if any

• Set up the DocuColor 40 CP to accept print jobs from your computer

• Configure a port on each Windows NT computer for the network or connection 
type

For this type of connection: See:

Parallel  below

 TCP/IP (lpr port) page 27

IPX (Novell) page 30
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Completing the Windows NT 4.0 parallel port connection

The parallel port cable connects the DocuColor 40 CP to a single computer. Once you 
have installed the Adobe PostScript printer driver and the DocuColor 40 CP PPD, 
complete the setup for parallel port printing.

TO SET UP PARALLEL PRINTING FOR WINDOWS NT 4.0:

1. Click the Start button, choose Settings, and then choose Printers.

2. Double-click the DocuColor 40 CP icon and choose Properties from the Printer menu.

In the Ports tab, confirm that LPT1 (Local Port) is checked.

The DocuColor 40 CP is ready to accept parallel print jobs from your computer, using 
the Adobe PostScript printer driver and the DocuColor 40 CP PPD.

3. Click the General tab and click Print Test Page.

4. Click the Sharing tab if you want to share the DocuColor 40 CP with network users. 
Select Shared, and select a share name.

Select the operating system or systems used by your network clients if you want to 
install a printer driver that those clients can download.

5. Click OK to exit the Printer Properties dialog box.

Completing the Windows NT 4.0 TCP/IP connection

Once you have installed the Adobe PostScript printer driver and the 
DocuColor 40 CP PPD, complete the setup for the TCP/IP and lpr connection as 
follows:

• Prepare the DocuColor 40 CP to accept print jobs using TCP/IP and lpr protocols. 
(For details, see the Configuration Guide.)

• Configure the workstation for the TCP/IP connection.

Before you continue, ask the system administrator for the IP address assigned to the 
DocuColor 40 CP, as well as the subnet mask and the gateway address, if they are 
used.
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The TCP/IP Protocol and Microsoft TCP/IP Printing software should already be 
installed on the Windows NT workstation.

TO SET UP TCP/IP AND LPR PRINTING FOR WINDOWS NT 4.0:

1. Open the Properties dialog box for the DocuColor 40 CP, and click the Ports tab.

2. Click Add Port.

The available port types are displayed.

3. Select LPR Port and click New Port.

If the LPR port is not listed, install the TCP/IP protocols. See the Configuration Guide 
or your Windows NT documentation.
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4. Enter the IP address of the DocuColor 40 CP. 

If your network uses Domain Name Services (DNS), enter the DNS name assigned to 
the DocuColor 40 CP instead of the IP address.

5. Press Tab and type the internal name of the DocuColor 40 CP.

This name can be simply the print queue name or it can be of the form 
queue_devicename. The name must be one of the following:

print
hold
print_DocuColor
hold_DocuColor

NOTE: This name is case-sensitive; type it exactly as shown above.

6. Click OK.

The workstation checks the address or DNS name you entered and notifies you if it 
cannot resolve the address.

7. Click Close in the Printer Ports dialog box.

The new port configuration is reflected in the Ports tab. You should now print a test 
page to verify the connection.

8. Click the General tab and click Print Test Page.

When you print, your PostScript files are transmitted over the LPR Port connection to 
the DocuColor 40 CP.

9. Click OK to close the Printer Properties dialog box.
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Completing the Windows NT 4.0 IPX (Novell) connection

Complete the setup for the IPX (Novell) connection as follows:

• Configure the Novell network and file server for handling DocuColor 40 CP print 
jobs.

The file server should be configured with a print server and print connection for the 
DocuColor 40 CP. For details, see your NetWare documentation.

• Prepare the DocuColor 40 CP for IPX printing.

• Set up the IPX connection on the workstation.

NetWare protocols (NWLink IPX/SPX Compatible Transport) and NetWare client 
services should already be installed on the Windows NT workstation.

TO SET UP IPX (NOVELL) PRINTING FOR WINDOWS NT 4.0:

1. Double-click Network Neighborhood.

2. Double-click NetWare or Compatible Network.

A list of NetWare servers is displayed.

3. Double-click the NetWare Tree or File Server on which the network administrator 
defined a print connection for the DocuColor 40 CP.

You may have to log in to the file server as a guest to see the print connections.
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4. Double-click the print connection defined for the DocuColor 40 CP.

If the NetWare server does not have a suitable driver for the DocuColor 40 CP you 
may be asked if you want to set up the printer on your workstation.

5. Click Yes.

The Add Printer Wizard appears.

6. Specify if you print from MS-DOS programs and click Next.

If you select Yes, you will need to capture a printer port before continuing.

7. In the dialog box displaying lists of manufacturers and printers, click Have Disk.

The Install from Disk dialog box prompts you for the disk.
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8. If you are installing from the CD, type the name of the CD-ROM drive (for example, 
D:\), and click Browse. Browse to the English\Instalrs\Ps_drvr\WIN_NT4x folder and 
click Open.

If you are installing from the installer files you downloaded with the Installer 
WebTool, type the name of your hard disk drive (for example, C:\), and click Browse. 
Browse to the Prntdrv\Ps_drvr\WIN_NT4x folder and click Open.

Make sure “Ntprint.inf” is selected in the Look in box.

The path is copied to the Install from Disk dialog box.

9. Verify the path is correct, and click OK.

10. In the Printers box, select the DocuColor 40 CP PPD file and click Next.
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11. Using a maximum of 20 characters, enter a name for the DocuColor 40 CP (or leave the 
default name) in the Printer name box, and choose whether you want the 
DocuColor 40 CP to be your default printer. Click Next.

NOTE: Entering more than 20 characters may cause printing problems with some 
network applications.

12. Indicate whether you want the printer installed as a shared printer. Click Next.

If you select Shared, you must also enter a Share Name for the printer (or leave the 
default name) and make selections from the list of operating systems used by client 
workstations. For information on shared printers, see the Configuration Guide.

13. Click No in the next dialog box to postpone printing a test page, and click Finish.

When installation is complete, a new printer window appears, with the name of the 
print queue on the NetWare server.
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14. Choose Properties from the Printer menu and click the Ports tab.

The NetWare queue you just connected to is listed and checked as a port for the 
DocuColor 40 CP.

15. Click the General tab and click Print Test Page.

The DocuColor 40 CP polls the NetWare server for print jobs in the print connection 
defined for the DocuColor 40 CP. When you print, your PostScript files are spooled to 
that connection and transmitted over the queue “port” to the DocuColor 40 CP.

The test page job is listed in the queue window until it is printed.

Installing DocuColor 40 CP software
The User Software CD includes software installers for the DocuColor utilities 
(Downloader and Print Calibrator). This software is supported with Windows 95 and 
Windows NT 4.0 only, and must be separately installed on each user’s computer.

NOTE: The DocuColor utilities are not supported with Windows 3.1x or over IPX 
(Novell) or IPX/SPX networks.
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Downloader and Print Calibrator

The installers for the two DocuColor utilities (Downloader and Print Calibrator) are 
the same. Before you begin the installation, determine the following:

• Where do you want to install the utility on your hard disk?

By default, the installer places the utility in a folder named “Xerox” on the top level 
of your hard disk.

• What do you want to name the utility folder in the Windows\Start Menu\Programs 
folder?

By default, the installer names the folder “Xerox.”

TO INSTALL DOWNLOADER AND PRINT CALIBRATOR:

1. On the User Software CD, browse to the English\Instalrs folder.

2. If you are installing Downloader, double-click to open the Download\Disk1 folders.

If you are installing Print Calibrator, double-click to open the Calib\Disk1 folders.

3. Double-click the Setup.exe icon.

4. Follow the instructions in the Setup dialog boxes to complete installation.

Instructions

Click when finished

Name of dialog box
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Use the table below as a guide when installing Downloader and Print Calibrator. For 
specific instructions, read the information in each dialog box.

Using the software for the first time
Before you can use the newly installed software, you must properly configure the 
connection to the DocuColor 40 CP.

Configuring the connection to the server

The first time you use one of the utilities, you are prompted to configure the 
connection to the DocuColor 40 CP.The same configuration is used for Downloader 
and Print Calibrator, so any change in the configuration affects both of these.

BEFORE YOU BEGIN:

• Print the Configuration page from the Control Panel and note the IP Address of the 
DocuColor 40 CP. 

You can also set up a Domain Name Server (DNS) for the IP address of the 
DocuColor 40 CP in the printcap file and use that name. See your Windows system 
documentation for information.

Name of dialog box: Action: When finished:

Welcome Read the Setup program 
introduction.

Click Next.

Choose Destination Location Specify a hard disk location for the 
installed utility software.

Click Next.

Select Program Folder Specify a folder name for the utility 
software located in the Programs 
menu.

Click Next.

Start Copying Files Verify the information in the 
Current Settings area.

Click Next.

Information Acknowledge that the software 
installation is complete.

Click OK.
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TO CONFIGURE THE CONNECTION TO THE DOCUCOLOR 40 CP:

1. Launch Downloader or Print Calibrator by double-clicking its icon or by choosing it 
from the Start>Programs menu.

2. Click OK.

3. Enter the appropriate information for the DocuColor 40 CP.

Nickname—Enter a name for the DocuColor 40 CP. This name can be any name you 
wish; it does not have to match the actual Server Name of the DocuColor 40 CP.

NOTE: The Nickname cannot contain any of the following seven characters:
[ ] _ " ' <space> <tab>

Protocol—Choose TCP/IP from the pop-up menu. (The DocuColor utilities are not 
supported over IPX (Novell) or IPX/SPX networks.)
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Server Name—Enter the IP address (or DNS name) of the DocuColor 40 CP.

New Device—Enter the name of the device that the DocuColor 40 CP is connected to: 
DocuColor. This device name appears in the Printer Setup section of the Configuration 
page.

4. When you have entered all the information, click Add.

5. With the device name (DocuColor) selected in the Devices list, click OK.

The DocuColor 40 CP appears in the list of available servers. The first line of the entry 
displays the nickname you gave the server, followed by the protocol you chose. The 
second line displays the device name.

6. With the device name (DocuColor) selected in the list of Available Servers, click OK to 
begin using the software.

Modifying the configuration

You should edit the configuration whenever there is any change to your 
DocuColor 40 CP server or network, such as an IP Address or DNS name. First 
change the specific DocuColor 40 CP Setup information before configuring the 
connection.

TO MODIFY THE CONFIGURATION:

1. To edit information for a DocuColor 40 CP in the list of available servers, select the 
DocuColor 40 CP by its nickname and click Modify. Edit information in the Modify 
Server Settings dialog box as necessary, and click OK when finished.

2. To add a new DocuColor 40 CP to the list of available servers, click Add. Configure the 
Add New Server dialog box as outlined in step 3 through step 5 above.

3. To remove a DocuColor 40 CP from the list of available servers, select the 
DocuColor 40 CP by its nickname and click Remove; then click Yes in the Remove 
dialog box.
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Copying color files from the User Software CD
You can copy additional color files from the User Software CD to your hard disk. 
Many of the files are PostScript files that you can download and print using 
Downloader.

The User Software CD contains the following color files:

Icm folder ICM printer profiles specially designed for use with the 
DocuColor 40 CP, your particular copier model, and the 
Windows color management system. For instructions on 
installing these profiles, see “Installing the DocuColor 40 CP 
ICM printer profile for Windows 95” on page 40.

Photoshp folder Separation Tables for use with Adobe Photoshop and the 
DocuColor 40 CP. The Separation Tables match 
RGB-to-CMYK conversions performed in Photoshop to those 
performed on the DocuColor 40 CP by color rendering 
dictionaries (CRDs).
Calrgb.ams, a monitor settings file that sets the proper source 
color space.
For instructions on installing these files, see “Installing files for 
Adobe Photoshop” on page 41.

Clrfiles folder Cmyk_ref.ps, an 11-page, letter-size PostScript file to use for 
reference when defining CMYK colors in applications.
Pantone.ps, a 19-page, letter-size PostScript file that indicates 
the closest equivalent of PANTONE coated colors that the 
DocuColor 40 CP and your particular copier model can 
produce. The method used to print the Pantone.ps file differs 
depending on the Spot Color Matching setting. For more 
information, see the Printing Guide and the Color Guide.
Rgb_01.doc, a file you can print from Microsoft Word 6.0 or 
later to view available RGB colors.
Rgb_02.ppt, a file you can print from PowerPoint 4.0 or later 
to view available RGB colors.
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Installing the DocuColor 40 CP ICM printer profile for 
Windows 95

Use the following procedure to install the DocuColor 40 CP ICM printer profile.

NOTE: The ICM printer profile should not be installed for printing with the Microsoft 
Office 97 suite of applications. If you print from Microsoft Office 97 with the ICM 
profile installed, JPEG, BMP, and TIFF images print incorrectly.

For information on ICM profiles and color management, see the Color Guide.

TO INSTALL THE ICM PROFILE:

1. On the User Software CD, open the Icm folder.

2. Copy the ICM profile (Efxx4010.icm) to the Windows\System\Color folder on your hard 
disk.

3. In the Color folder, right-click to select the ICM profile.

Calibrat folder
(inside Clrfiles 
folder)

Four PostScript files of color patches: custom21.ps, 
custom34.ps, stand21.ps, and stand34.ps. 
The numbers in the filenames refer to the number of patches 
on the page.
The Custom files are provided to enable you to download 
measurement patches that incorporate the copier’s current 
calibration set. The Standard files are provided to enable you to 
download standard measurement patches that ignore the 
copier’s current calibration set.
NOTE: These files are provided for expert users and should not 
be used for day-to-day calibration.



41 Copying color files from the User Software CD
4. Choose Install in Place from the menu that appears.

In the Windows\System\Color folder, the icon for the ICM profile is now white, 
indicating that it is installed.

Installing files for Adobe Photoshop

If you use Adobe Photoshop, install the Separation Tables and the Calrgb.ams monitor 
settings file for best color printing results. These files are found on the User Software 
CD in the Photoshp folder.

Loading the Separation Tables

The Separation Tables enable RGB-to-CMYK conversions within Photoshop that 
correspond to conversions performed by color rendering dictionaries on the 
DocuColor 40 CP.

TO LOAD THE SEPARATION TABLES:

1. On the User Software CD, open the Photoshp folder.

2. Copy the files “Dc40cpp.ast” and “Dc40cps.ast” to your Adobe Photoshop folder.

3. Launch Photoshop.

4. For Photoshop 4.0, from the File menu, choose Color Settings, and from the Color 
Settings submenu, choose Separation Tables.

For Photoshop 3.0 and Photoshop 2.5, from the File menu, choose Preferences, and 
from the Preferences submenu, choose Separation Tables.
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5. In the Separation Tables dialog box, click Load.

6. Browse to the Adobe Photoshop folder, select the appropriate file, and click Open 
(Photoshop 4.0) or OK (Photoshop 3.0 or 2.5).

Select the Dc40cpp.ast file for separating photographic RGB images to CMYK. 
Select the Dc40cps.ast file for separating solid color RGB images to CMYK.

7. Verify that the file you selected appears after “Use Table:” in both places and click 
OK.

Separation tables remain loaded the next time you start Photoshop, unless you remove 
them.

Loading the monitor settings file

The Calrgb.ams monitor settings file for Photoshop defines the source color space for 
printing to the DocuColor 40 CP.

TO LOAD THE MONITOR SETTINGS FILE:

1. On the User Software CD, open the Photoshp folder.

2. Copy the Calrgb.ams file to your Adobe Photoshop folder.

3. Launch Photoshop.
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4. For Photoshop 4.0, from the File menu, choose Color Settings, and from the Color 
Settings submenu, choose Monitor Setup.

For Photoshop 3.0 or Photoshop 2.5, from the File menu, choose Preferences, and 
from the Preferences submenu, choose Monitor Setup.

5. In the Monitor Setup dialog box, click Load.

6. Browse to your Adobe Photoshop folder, select the Calrgb.ams file, and click Open 
(Photoshop 4.0) or OK (Photoshop 3.0 or 2.5).

The Calrgb.ams file appears as the selection in the Monitor pop-up menu of the 
Monitor Setup dialog box.

7. Under Room Parameters, set Ambient Light to High and click OK.
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The general steps for installing the DocuColor 40 CP user software and setting up 
printing on a Mac OS-based computer are:

• Install the Adobe PostScript printer driver and DocuColor 40 CP PostScript Printer 
Description files (PPDs).

• Set up the DocuColor 40 CP in the Chooser.

• Install Downloader.

• Install Print Calibrator.

• Install the ColorSync™ profiles.

• Install the screen fonts.

• Copy additional color-reference and application-specific files from the User Software 
CD as needed.

Installing Mac OS software
The Installers folder on the User Software CD contains the following installer folders:

• ColorSync™ Profiles Installer—DocuColor 40 CP ColorSync ICC profiles installer

• Downloader—Downloader installer

• Print Calibrator—Print Calibrator installer

• Printer Driver—Adobe PostScript printer driver and PPD installer

NOTE: An installer is not provided for the Mac OS screen fonts; they must be copied 
directly from the User Software CD to the System Folder:Fonts folder on your hard 
disk. For instructions, see “Screen fonts” on page 51.

In addition, the User Software CD contains various color files. These files can be 
copied or installed from the CD and placed in the appropriate locations on your hard 
disk (see “Copying color files from the User Software CD” on page 52).

• PostScript CMYK color reference file

• PostScript PANTONE Coated color reference file

Installing User 
Software on a 
Mac OS 
Computer
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• RGB color reference files for specifying colors from Microsoft Word and PowerPoint

• Separation Tables and a monitor settings file for use with Adobe Photoshop

NOTE: If you operate the DocuColor 40 CP in a copy shop, quick print shop, or service 
bureau, you might want to provide copies of the printer driver, PPD files, separation 
tables, and relevant documentation to customers. This ensures that jobs they prepare 
are properly formatted for printing to the DocuColor 40 CP.

Downloading printer files with the Installer WebTool
Installers for the DocuColor 40 CP printer files can be downloaded from the 
DocuColor 40 CP with the Installer WebTool (if the site administrator has enabled 
Internet access to the DocuColor 40 CP). For instructions, see “Using the Installer 
WebTool” on page 58.

Once you download the installers, the installation process is identical to installing from 
the User Software CD.

Setting up PostScript printing with Mac OS
To set up the DocuColor 40 CP as a PostScript printer, you must install the Adobe 
PostScript printer driver, and the PPD file that corresponds to your copier. The 
AdobePS printer driver and PPD files are provided on the User Software CD.

Printer drivers provide a way to communicate information on print jobs between your 
applications, the DocuColor 40 CP, and any other PostScript printer connected to 
your computer.

You can use the following procedures whether you are installing from the User 
Software CD or with installer files downloaded using the Installer WebTool.
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TO INSTALL THE ADOBEPS PRINTER DRIVER AND PPD FILES:

1. If you are installing from the CD, open the Installers:Printer Driver folder.

If you are installing from the installer files you downloaded with the Installer 
WebTool, open the Printer Driver folder on your hard disk.

2. Double-click the AdobePS Installer icon.

A warning dialog box appears.

3. Click Yes to continue with installation of printer driver software, and to confirm that 
your computer must be restarted after installation.

The AdobePS Installer installs the Adobe PostScript printer driver, the PPD file that 
corresponds to your copier, and the Apple Chooser.

4. Click Restart when installation is complete.

Setting up the DocuColor 40 CP in the Chooser
After you install the AdobePS printer driver and PPD files (see “Setting up PostScript 
printing with Mac OS” on page 46), you need to set up the DocuColor 40 CP in the 
Chooser in order to take full advantage of its features. This section describes how to set 
up the DocuColor 40 CP with the AdobePS printer driver.
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TO SET UP THE DOCUCOLOR 40 CP IN THE CHOOSER:

1. Select Chooser from the Apple menu.

2. Click the AdobePS icon.

Make sure AppleTalk is set to Active.

3. Select the correct AppleTalk Zone, if necessary.

4. Select the DocuColor 40 CP from the “Select a PostScript Printer” list, and click Setup.

The DocuColor 40 CP appears in the list in the form of <server name>_ 
<device name>_ <print connection>. The device name (DocuColor) is the model of 
your copier.The AdobePS printer driver automatically selects the correct PPD file for 
your DocuColor 40 CP.

NOTE: The Hold queue for the DocuColor 40 CP is always enabled; the Print queue 
and the Direct connection may also be available. If more than one DocuColor 40 CP 
print connection is available, you must perform step 4 for each connection you want to 
print to.

5. Close the Chooser.
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Installing DocuColor 40 CP software and fonts
Before you begin each of the following installation procedures, determine where you 
want to install each item on your hard disk. By default, the files are placed in the 
following locations:

• The ColorSync Profiles are placed in the System Folder:Preferences folder on your 
hard disk.

If your system uses ColorSync, you must install these profiles in the ColorSync 
Profiles folder inside the System Folder:Preferences folder. You should install the 
ColorSync profiles only if your system uses them.

• Downloader is placed in a folder named “Xerox” on the top level of your hard disk.

• Print Calibrator is placed in a folder named “Xerox” on the top level of your hard 
disk.

NOTE: An installer is not provided for the Mac OS screen fonts; they must be copied 
directly from the User Software CD to the System Folder:Fonts folder on your hard 
disk. For instructions, see “Screen fonts” on page 51.

TO INSTALL MAC OS SOFTWARE:

1. On the User Software CD or your hard disk, double-click to open the Installers folder.

2. Double-click the Installer icon.

If you are installing: Double-click:

ColorSync profiles To open the ColorSync™ Profiles Installer folder

Downloader To open the Downloader folder

Print Calibrator To open the Print Calibrator folder
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3. Click Install.

4. Specify the locations into which to install each item.

Use the table below as a guide when installing software.

5. If prompted, click Quit to close the software installer.

If you are installing: Action: To install:

ColorSync Profiles Browse to the System Folder:
Preferences:ColorSync™ Profiles folder.

Perform the steps in “To set the ColorSync 
system profile:” on page 51 after installation 
is complete.

Click Install into 
ColorSync™ 
Profiles.

Downloader Specify a hard disk location for the installed 
Downloader software.

Click Install.

Print Calibrator Specify a hard disk location for the installed 
Print Calibrator software.

Click Install.

Software to be installed

Disk space required for 
installation
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TO SET THE COLORSYNC SYSTEM PROFILE:

1. For ColorSync Profiles, choose Control Panels>ColorSync System Profile from the Apple 
Menu.

2. Click Set Profile.

3. From the list of ColorSync profiles, select EFIRGB ICC and click Select.

When selected as the ColorSync system profile, EFIRGB ICC sets the optimal source 
color space for printing to the DocuColor 40 CP. The color space set by the 
EFIRGB ICC profile is the same as that set by the EFIRGB setting of the RGB Source 
print option. For more information, see the Color Guide.

NOTE: The RGB Source print option setting overrides the ColorSync system profile 
setting. 

4. Close the ColorSync System Profile window.

Screen fonts
The User Software CD includes screen fonts that correspond to the 136 built-in 
printer fonts on the DocuColor 40 CP. In order to view and use these fonts, you must 
copy them from the User Software CD to your hard disk.

TO INSTALL SCREEN FONTS:

1. On the User Software CD, open the Fonts folder.

2. Copy the fonts that you want to install to the System Folder:Fonts folder on your hard 
disk.

If you have any applications open, you must quit and relaunch them before the newly 
installed screen fonts are available.
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Copying color files from the User Software CD
You can copy additional color files from the User Software CD to your hard disk. 
Many of the files are PostScript files that you can download and print using 
Downloader.

The User Software CD contains the following color files:

Photoshop folder Separation Tables for use with Adobe Photoshop and the 
DocuColor 40 CP. The Separation Tables match RGB-to-
CMYK conversions performed in Photoshop to those 
performed on the DocuColor 40 CP by color rendering 
dictionaries (CRDs).
Calibrated RGB, a monitor settings file that sets the proper 
source color space.
For instructions on installing these files, see “Installing files for 
Adobe Photoshop” on page 53.

Color Files folder CMYK Color Reference.ps, an 11-page, letter-size PostScript 
file to use for reference when defining CMYK colors in 
applications.
PANTONE Book.ps, a 19-page, letter-size PostScript file that 
indicates the closest equivalent of PANTONE coated colors 
that the DocuColor 40 CP and your particular copier model 
can produce. The method used to print the 
PANTONE Book.ps file differs depending on the Spot Color 
Matching setting. For more information, see the Printing 
Guide and the Color Guide.
RGB page 01, a file you can print from Microsoft Word 6.0 or 
later to view available RGB colors.
RGB page 02, a file you can print from PowerPoint 4.0 or later 
to view available RGB colors.
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Installing files for Adobe Photoshop 
If you intend to use Adobe Photoshop, install the Separation Tables and the monitor 
settings file for best color printing results. These files are located on the User Software 
CD in the Photoshop folder.

Loading the Separation Tables

The Separation Tables enable RGB-to-CMYK conversions (in Photoshop), which 
correspond to conversions performed by color rendering dictionaries on the 
DocuColor 40 CP.

TO LOAD THE SEPARATION TABLES:

1. On the User Software CD, open the Photoshop folder.

2. Copy the files “DocuColor 40 CP. P” and “DocuColor 40 CP.S” to your Adobe Photoshop 
folder.

3. Launch Photoshop.

Calibration 
folder (inside 
Color Files 
folder)

Four PostScript files of color patches: custom21.ps, 
custom34.ps, standard21.ps, and standard34.ps. 
The numbers in the filenames refer to the number of patches 
on the page.
The Custom files are provided to enable you to download 
measurement patches that incorporate the copier’s current 
calibration set. The Standard files are provided to enable you to 
download standard measurement patches that ignore the 
copier’s current calibration set.
NOTE: These files are provided for expert users and should not 
be used for day-to-day calibration.
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4. For Photoshop 4.0, from the File menu, choose Color Settings, and from the Color 
Settings submenu, choose Separation Tables.

For Photoshop 3.0 or Photoshop 2.5, from the File menu, choose Preferences, and 
from the Preferences submenu, choose Separation Tables.

5. In the Separation Tables dialog box, click Load.

6. Browse to your Adobe Photoshop folder, select the appropriate Separation Table file, 
and click Open.

Select the DocuColor 40 CP.P file for separating photographic RGB images to CMYK.
Select the DocuColor 40 CP.S file for separating solid color RGB images to CMYK.

7. Verify that the file you selected appears after “Use Table:” in both places and click 
OK.

Separation tables remain loaded the next time you start Photoshop, unless you remove 
them.

Loading the monitor settings file

The Calibrated RGB monitor settings file for Photoshop defines the source color space 
for printing to the DocuColor 40 CP.

TO LOAD THE MONITOR SETTINGS FILE:

1. On the User Software CD, open the Photoshop folder.

2. Copy the Calibrated RGB file to your Adobe Photoshop folder.

3. Launch Photoshop.
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4. For Photoshop 4.0, from the File menu, choose Color Settings, and from the Color 
Settings submenu, choose Monitor Setup.

For Photoshop 3.0 and Photoshop 2.5, from the File menu, choose Preferences, and 
from the Preferences submenu, choose Monitor Setup.

5. In the Monitor Setup dialog box, click Load.

6. Browse to your Adobe Photoshop folder, select the Calibrated RGB file, and click Open.

The Calibrated RGB file appears as the selection in the Monitor pop-up menu of the 
Monitor Setup dialog box.

7. Under Room Parameters, set Ambient Light to High and click OK. 
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DocuColor WebTools allow you to manage your DocuColor 40 CP remotely from the 
Internet or from your company’s intranet. The DocuColor 40 CP has its own home 
page, from which you are able to select from a variety of functions including 
WebSetup, Status, WebSpooler, WebLink, and Installer.

For more information on using WebTools, see the Printing Guide and the Job 
Management Guide.

Setting up WebTools
In order for network users to access and use WebTools, you need to set certain 
DocuColor 40 CP options in Network Setup and Printer Setup. You also need to 
prepare each user’s workstation to communicate with the DocuColor 40 CP over the 
Internet or intranet.

For more information about DocuColor 40 CP Setup, see the Configuration Guide.

TO VERIFY THAT WEBTOOLS ARE SET UP ON THE 
DOCUCOLOR 40 CP:

1. Print the Configuration page from the Control Panel. 

For instructions, see the Job Management Guide.

2. On the Configuration page, check the following:

• In Network Setup>Port Setup, confirm that the appropriate network type (Ethernet 
or Token Ring) is enabled.

• In Network Setup>Protocol Setup>TCP/IP Setup, confirm that TCP/IP is enabled 
and that there is a valid, unique IP Address for the DocuColor 40 CP.

• In Network Setup>Service Setup, confirm that Web Services are enabled.

• In Printer Setup, confirm that the Print Queue is published.

3. If all the conditions listed in Step 2 are currently set, the DocuColor 40 CP is properly 
set up to use WebTools.

Downloading 
Installers with 
WebTools
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If any of the conditions listed in Step 2 are not currently set, you must change them (as 
described in the Configuration Guide) before you can use WebTools.

TO SET UP CLIENT WORKSTATIONS FOR USE OF WEBTOOLS:

1. Enable TCP/IP networking.

2. Make sure the workstation has a valid, unique IP address.

3. Make sure the workstation is installed with one of the following Internet browsers:

Windows 95 and Windows NT—Either Netscape Communicator v4.0.4 or Microsoft 
Internet Explorer v3.0.2

Mac OS—Netscape Communicator v4.0.4

NOTE: Netscape and Microsoft continue to release frequent updates to their browsers. 
As support cannot be guaranteed for all versions, use the versions specified above for 
best results.

4. Make sure Java is enabled in your Internet browser.

For more information on setting up the DocuColor 40 CP and your network, see the 
Configuration Guide.

Using the Installer WebTool
The Installer WebTool duplicates the printer driver installers on the User Software 
CD, allowing you to easily download printer files from the DocuColor 40 CP to your 
workstation.

TO DOWNLOAD PRINTER FILES INSTALLERS WITH THE 
INSTALLER WEBTOOL:

1. Launch your Internet or intranet browser and enter the DNS name or IP address of the 
DocuColor 40 CP.

2. Select a login level, enter a password if necessary, and click OK.

No password is required to log in as Guest. You have full access to the Installer 
WebTool when logged in as Guest.
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3. Click the Installer button.

4. Under the name of your operating system, click “Printer Files.”

For Windows computers, a dialog box appears, prompting you to save the file 
“Prntdrve.exe” to the location you choose.

For Mac OS computers, a folder named “Printer Driver” is downloaded to the desktop 
in a BinHex-encoded, compressed format. If your internet browser is equipped with an 
expander utility such as StuffIt Expander, the folder will be decoded and decompressed 
automatically.

5. For Windows computers, browse to the location where you want to save the 
Prntdrve.exe file and click Save.

For Mac OS computers, if the Printer Driver folder was not automatically decoded and 
decompressed, launch a utility that will perform that function.
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6. For Windows computers, double-click the Prntdrve.exe file, browse to the location 
where you want to install the Prntdrv folder, and click Next.

The Prntdrv folder is installed to the location you specified.

7. Install the appropriate printer files for your operating system.

For instructions on installing 
the printer files for: See:

Windows 95 “Setting up PostScript printing with Windows 95” on 
page 2

Windows 3.1x “Setting up PostScript printing with Windows 3.1x” on 
page 17

Windows NT 4.0 “Setting up PostScript printing with Windows NT 4.0” 
on page 22

Mac OS computers “Setting up PostScript printing with Mac OS” on 
page 46.
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This chapter provides troubleshooting tips for some problems that may arise when 
performing the procedures in this manual.

On a Windows computer

Setting up IPX (Novell) printing for Windows NT Workstation

If you have problems installing the DocuColor 40 CP with Windows NT, try 
installing another PostScript printer (such as the Apple LaserWriter IIg), and then 
install the DocuColor 40 CP. Installing another printer insures that all files are 
properly installed and available. For instructions, see your Windows NT 
documentation.

Installing the Adobe PostScript Printer Driver

If you are reinstalling the Adobe PostScript Printer Driver, delete any previous versions 
and related files before installing. Search for and delete all files named Efxx*.* in the 
Windows\System folder and the Windows\System\Color folder. See the Adobe 
README file included with the printer driver for more information.

Problems with the DocuColor utilities on Windows 95 or 
Windows NT

1. If you are using Windows 95, make sure that IPX/SPX and TCP/IP networking protocols 
are both enabled. 

See “Completing the Windows 95 IPX/SPX or IPX (Novell) connection” on page 10.

2. Make sure that the connection is configured correctly for your site.

To check the current configuration, launch a DocuColor utility and choose Open from 
the File menu. Select the DocuColor 40 CP and click Modify to see current settings. If 
the settings are incorrect, you can change them in this dialog box.

Troubleshooting
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Setting up the DocuColor 40 CP in the Chooser

If auto-setup does not work and you are prompted to select the PPD, select the 
appropriate DocuColor 40 CP file in your System Folder:Extensions:Printer 
Descriptions folder.

Installing screen fonts

If you experience problems installing the PostScript screen fonts from the User 
Software CD to the System Folder:Fonts folder, try the following:

1. Quit all applications and close all windows.

2. Create a new folder and name it “Uninstalled Fonts.”

This folder must be located outside of the System Folder.

3. Move fonts that you are not using from the System Folder:Fonts folder to the 
Uninstalled Fonts folder.

4. Continue to copy fonts from the User Software CD to the System Folder:Fonts folder.

5. Create an alias to the System Folder:Fonts folder and to the Uninstalled Fonts folder.

6. Place both aliases on your desktop.

7. When necessary, use the aliases to open both folders and move fonts between them.

If you have any applications running, you must quit and relaunch them in order to 
view and use the newly installed fonts.

Alternately, you can try combining fonts from multiple suitcases into a single suitcase.
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